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1. Introduction. 
 

AraWord is a free distribution computing application, belonging to the suite of tools 
for augmentative and alternative communication AraSuite 
(http://sourceforge.net/projects/arasuite/), which consists in a text editor that allows 
simultaneous writing of text and pictograms, facilitating the production of materials and 
the adaptation of texts for people with difficulties in the field of functional communication. 
 
 

 
 
AraWord is also a very useful tool for those users who are acquiring the process of reading 
and writing, as the appearance of the pictogram at the time of writing is a highly positive 
reinforcement to recognise and evaluate that the written word or sentence is correct. 
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2. Installation and update of the pictograms database. 
 
To download and install it, you should enter AraSuite webpage in SourceForge  
(http://sourceforge.net/projects/arasuite/) and click on the Download button.  
 

 
 

 MacOS and Linux versions can be downloaded from this other webpage:   

http://sourceforge.net/projects/arasuite/files/ 

 

http://sourceforge.net/projects/arasuite/
http://sourceforge.net/projects/arasuite/files/
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Once you press the Download button, a new page will appear. You should wait a few 

seconds until the window of the zip file download is open.   

 

 
When you download the file, you should double click on it and follow the installation 

process without modifying the default parameters. 

 

Before the installation of AraSuite, it is advisable that you uninstall the previous version of 

AraWord and delete the AraSuite folder that you had already installed in your C:\ disc. 
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The pictograms are installed afterwards in a parallel database that will be automatically 

updated as the new pictograms are uploaded.  

 

When the installation process is over, there will appear a new folder with AraSuite in the 

Start menu of your computer. 

 

 
 

As you will see, AraSuite also contains TICO Interpreter and TICO Editor applications, 

from the TICO Project (generator of Interactive Communication Boards), which is included 

in the Suite too.  

 

To finish the installation process, you should click on the Gallery Manager icon and, 

afterwards, on "Check for updates". In the new window you will read “There is a new 

version of the pictograms”. Click on Update to download the pictograms that you will 

later use with AraWord and with TICO. 

 

 
 

Once the update process is finished, you can use both applications with the whole database 

of ARASAAC pictograms and enjoy the new implementations both apps incorporate.  

3. File Menu. 
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When you open the app, you will see the     interface is very simple and the toolbar offers 

the most basic elements so that it can be used, not only by professionals or families but 

also by the users of augmentative and alternative communication. 

 
 

The Araword icon appears at the beginning showing where the cursor is placed. You can 

delete it to start writing. 

Let’s analyse the different options that appear in the File Menu.  

 

Firstly, there appears the New option, which allows you to start a new text without saving 

the previous one. 
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Afterwards you can click on Save as… to save the text you are working with and to be able 

to open it later and continue editing the material.  

Besides, all those customized pictograms (not belonging to ARASAAC database) imported 

to Araword and used in the document are also stored. In this way, regardless of the 

computer you use to open the document, all the pictograms are shown for sure.  

The files are saved with .awd format, so to open them you will have to do it directly with 

the Open option from the own application.  

 

 
 

In this version the Print option is already implemented through Export as.... (PDF). 

 

This menu offers two possibilities: Export as bitmap or Export as PDF. 

 

Within the option Export as... bitmap we recommend using the JPG format. If you do 

so, once the document is saved as image, you can insert it in any document or 

presentation.  
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Occasionally, at the time of saving and inserting the image, you may observe that the image 
shows an empty space around it. To optimize it, you can use the different applications of 
text editing and of creation of presentations which incorporate image clipping functions.  

 

 

 

 

In order to print AraWord documents we recommend using Export as... PDF. 
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The Export as PDF menu offers different possibilities that, as you configure them, will be 

shown on the Preview window: 

 

 Number of pictograms per line: this option allows us to adjust the number of 

pictograms that can be inserted in each line. The number of necessary lines will 

grow according to the number of pictos per line you select so that all the text fits. 

 Add ARASAAC license: this option is activated by default and adds ARASAAC 

license term as a footnote, thus guaranteeing the free distribution of the document. 

 Landscape PDF: If you activate this option, the document changes its position to 

Landscape (Horizontal).  

 

 
 

After you have defined the options you like and you have customized the final appearance 

of the document, click "Export PDF". A new window will appear to save the PDF in your 

computer.   
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Once saved you can open it in any PDF reader and print it from there.  

 4. Editing Menu. 
The Editing Menu shows the most simple options of any Word processor. 

 

One of the most striking options is pasting a text we have previously copied from the 

Internet. Let’s see an example. 

 

We select a text from the Internet using Ctrl+C and we copy it. 
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We immediately go to AraWord and use the Paste option from the Editing Menu. 

  

 
As you will see, the result is awesome. You will only have to use some tools we’ll explain 

afterwards to obtain the desired result. 

5. Text Menu. 
 

In this menu, you can choose the text Format  (Font, size, color, …), the Placement 

(over/under the pictogram), change a Text to upper-case / lower-case letters and 

select the Document language.  

 

 
 

In the case of converting the Text to upper /lower-case letters, you can convert all 

the elements of the text or just the selected element (the cursor should be placed within 

this pictogram)  
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The Placement option allows us to place the text Over the pictogram or Under the 

pictogram, according to the user’s needs.  

 

Finally, if you use the Document language option, you could choose among the different 

languages the pictograms are translated to, except those whose graphic symbols don’t 

appear on a Spanish keyboard  (Chinese, Arabic, Romanian, Polish, …). 

 

 
 

AraWord conjugates all verb tenses in Spanish and some verbs in Catalan.  

 

 
 

In other languages, like English, you have to use the infinitive (with "to") and then, with 

the option “Change the name” F5 (that you will see afterwards), write the verb conjugated 

in the corresponding tense.   

6. Pictogram Menu. 
This is, doubtless, one of the most important menus of the application.  
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From this menu, you can configure the Size of the pictograms adapting them to the 

desired size. 

 

Then, you can use three of the most important options to adapt any text to pictograms: 

Next image, Compound /Split word and Change name. You can activate these 

options in different ways, using the tools menu, the function keys or the icons of the 

toolbar.  

 
 

If you are placed on a pictogram (i.e.: "girl") and click on the F3 key or on the 

corresponding icon, the application allows you to select the pictogram of girl that better 

suits your text.  As the application database contains different pictograms for “girl”, you 

have the option to choose the one you prefer, including the photographs or images you 

have associated to that entry.  

 

In the last version of AraWord we have included the possibility of using the word as 

pictogram instead of the pictogram or photograph. For that purpose, click on F3 until the 

text appears.  

 

F3 Next image 

F4 Compound/split word F5 Change name 
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The F4 key or the icon shown on the screenshot is used to Compound / Split a word. If 
you write a compound word (i.e.: "Clothes shop"), you will see the pictogram and text 
automatically appear in a single cell. Maybe you want to show the words separately. In that 
case, click on the key or icon of the corresponding cell and the application splits the cell 
into the 2 pictograms that form the word.  

 

 
 
The F5 key or the corresponding icon is used to Change the name of a pictogram. On the 
next screenshot we write “GIRL” many times. We place the cursor within the 
corresponding pictogram and we click on F5 key or on the icon.  You will observe you can 
delete the text and write, for example, “FEMALE” or other entries; even proper names.  
 

 
 

CLICK  F4 
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Within this menu you also have the options to Show / Hide the Image or the Border of One 
element /All the elements. We recommend you to do some trials to get used to these 
options.  
 
In the last version of AraWord we have added the possibility to convert the pictograms to 
Gray Scale, which certainly facilitates the creation of documents easily printable in black 
and white.  

 
 
 
 
 

 
 

 
When you click on the "Gray Scales" option, an emerging window appears with 256 
established in Levels.  If you click on Accept, the pictograms you have until that moment 
will be converted to Gray Scale. The new pictos that appear while you write, will also be 
converted to the Gray Scale.  
 

 
 
If you want to see the pictograms back in color, click on "Gray Scale" from the Pictograms 
Menu and in the emerging window write number 0 instead of 256  and then Accept.   
 

 
 

In case you want them back again in Gray, write 256. 

7. Tools Menu. 
 
This menu offers three sections: Resource Manager, General Preferences and Voice 
Synthesis. 
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From Resource Manager, we are going to Add an Image to Arasuite database to be able 

to use it in AraWord. For that purpose, click on Tools, Resource Manager and Add Image. 

 

 
 

From this window, click on Select and search the image in your computer. This image can 

be placed in any folder. You only have to select it.  
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Then click on the plus symbol (+) to add the meaning corresponding to this image. A 

new line will appear. There, you have to insert the Term, the Language in which you will be 

using the image, and Type, which will define the color of the image frame.  
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Once finished, click on Save changes and you will automatically have the image ready to 

be used in the processor.  

You can add different entries at the same time. For instance: girl, female, lady, adolescent, 

damsel,… 

 

 
 

The final result, after Saving the changes, will be the following: 
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This process is very easy and all the images and their corresponding entries will be stored 

in the database. Even if you uninstall and reinstall AraSuite, the database will not be 

modified and you won’t lose the work done.  

In this new version of AraSuite, you can find pictograms or images in the gallery through 

the menu Edit Image of the Resource Manager. This search will allow you to copy and 

paste them in a document or presentation, modify their properties or remove them 

permanently from the database. 

 

 

 

There are two ways to find the pictograms or images: by key terms or by the name of the 

image.  

 

The search by key terms offers two pull-down menus where you can choose between the 

options “and” and “or”. If you choose “and”, the images belonging to all the keywords you 
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entered will be shown.  If you choose “or”, the images belonging to some of the keywords 

will appear.  

 

These options can be combined to do more complex searches. You can use the *symbol to 

select the keywords beginning, ending or containing the letter or set of letters entered.   

 

It is important to remember that, when you want to find pictograms in the database, the 

searches have to be done by key terms instead of by the name of the images. In that way, 

the searches can be done in the different available languages.  

 

Let’s see an example where we have done a search by key terms in three languages.  

 
 

The search by the name of the image allows you to find images different from ARASAAC 

pictograms that we have already inserted in AraSuite database by ourselves.    

 

This search can be done in different ways:  

 

 By the exact name of the image: you only have to write the name of the image 

you want to find and click on Find.  

 By names beginning with a certain letter or set of letters. If you want all 

the musical instruments you’ll search by instrument* and if you want all the images 

beginning with the letter 'a' you’ll search a*. 

 By names ending in a certain letter or set of letters: if you want all the 

words ending in 'tor' you’ll search *tor and if you want all the words ending in 'e' 

you’ll search *e. 

 By names containing a letter or set of letters: if you want all the words 

containing the syllable 'de' you’ll look for de* and if you want all the words 

containing the letter 'y' you’ll search *y*. 
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In our case, we have entered the name “shopping-girl” as exact name of the image and this 

is the result: 

 

 
 

In this case, there appears the image or photograph of the girl we have previously added. 

As you can see, there isn’t any ARASAAC pictogram because the search, as we have already 

explained, is done over filename.   

 

Now we know the different search systems that have been implemented in AraWord.  

 

If you enter the word “girl” in the search by keyword, it shows all the pictograms and 

images of the database whose keyword is “girl”.  

 

To edit the pictogram or image, you have to select it and click on Modify or just double-

click on it and there will appear a list with all the entries, in all the languages it appears and 

the type of word. Now you only have to choose the entry you want to change and modify it. 
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In case you want to remove the pictograms or the image, select it and click on Delete.  

 

A very interesting option that has been incorporated in this new version is Copy. To use 

this option, choose the pictogram or image, click on Copy and paste it directly on your 

document or presentation.  
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You can use this option directly, apart from AraWord, by using the program Gallery 

Manager, that you will find in AraSuite folder from the Start menu of Windows.  

 

 
 

In this way, you can open a pop-up window and, using the option Edit image and searching 

by key terms, you can copy the pictogram or the image and paste it on your document or 

presentation. 
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One of the other options you will find in 

the Tools Menu is General Preferences.  

Here you will be able to modify the initial 

configuration of ARASAAC, including the 

languages of the application interface and 

of the document.  The following times that 

you open the application, the configuration 

selected in this board of preferences will be 

applied by default.  

 

In the last version of AraWord we have 

added "Gray Scales" which initially 

appears at 0 so that the pictos are shown 

in colour. If you want the pictograms in 

Gray Scales, when you start a new 

document, set 256 instead of 0. 
 

One of the last novelties added in AraWord is the Reading of a text with Voice 

Synthesizer.   

 

To listen to the text you have written you can: 

 

 Click on Tools -> Voice Synthesis  

 Click on the button Voice Synthesis that appears at the end of the tools bar  

 Click on F7 . 

 

 

 
 

F7 
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http://arasaac.org/

